
MANAGING LONG DOCUMENTS NOTES 
 

UNIVERSITY OF WOLLONGONG PAGE I NOTES 

MASTER DOCUMENTS 
 

Table of Contents 
1. MASTER DOCUMENTS AND SUBDOCUMENTS 4 

1.1 THE RELATIONSHIP BETWEEN THE MASTER AND ITS 
SUBDOCUMENTS 4 

1.2 CREATE A NEW MASTER DOCUMENT 4 
1.3 TO ADD AN EXISTING WORD DOCUMENT INTO A MASTER 

DOCUMENT 5 
1.4 TO PRINT A MASTER DOCUMENT 5 
1.5 WORKING WITH SUBDOCUMENTS 5 

1.5.1 OPENING AND EDITING SUBDOCUMENTS 5 
1.5.2 REORGANIZING SUBDOCUMENTS 5 
1.5.3 REORGANISING SUBDOCUMENT CONTENT 6 
1.5.4 CHANGING SUBDOCUMENT DIVISIONS 6 
1.5.5 SPLITTING AND MERGING 6 
1.5.6 RENAMING AND MOVING SUBDOCUMENTS 7 
1.5.7 REMOVING SUBDOCUMENTS FROM THE MASTER 8 

2. STYLES 9 
2.1 APPLYING A STYLE 9 
2.2 WORKING WITH STYLES 9 
2.3 MODIFYING  STYLES 9 
2.4 REDEFINING THE DEFAULT (NORMAL) STYLE 10 
2.5 CREATING NEW STYLES 10 
2.6 USING THE STYLE COMMAND: 10 
2.7 DELETING A STYLE 10 
2.8 COPYING A STYLE TO THE NORMAL TEMPLATE 10 
2.9 COPYING A STYLE TO OTHER TEMPLATES OR DOCUMENTS 11 

3. WHAT STYLES DON’T CONTROL 11 

4. PAGE NUMBERS 11 
4.1 ADDING BASIC PAGE NUMBERS TO HEADERS OR FOOTERS TO 

YOUR MASTER DOCUMENT. 11 
5. FOOTNOTES 12 

5.1 INSERT A FOOTNOTE 12 
6. ENDNOTES 12 

7. INDEX 12 
7.1 CREATE AN INDEX 12 
7.2 AUTOMATICALLY MARK INDEX ENTRIES BY USING A 

CONCORDANCE FILE 13 
7.3 BUILDING AN INDEX 13 
7.4 UPDATING AN INDEX 13 

8. TABLE OF CONTENTS (TOC) 14 
8.1 CREATING A TABLE OF CONTENTS IN A MASTER DOCUMENT 14 
8.2 UPDATING A TABLE OF CONTENTS 14 

9. TABLE OF FIGURES, IMAGES, GRAPHS, TABLES. 14 
9.1 TO CREATE A TABLE OF FIGURES, YOU HAVE TO ADD 

CAPTIONS TO YOUR FIGURES (IMAGES, GRAPHICS, GRAPHS 
ETC.) 14 

9.2 INSERTING A TABLE OF FIGURES, LIST OF TABLES, ETC. 14 



NOTES MICROSOFT WORD 
  

NOTES ITS TRAINING PAGE II 

NOTE: ANY TEXT IN 
[SQUARE BRACKETS 
AND ITALIC] REFERS TO 
THE PC SHORTCUT. 

10. DOCUMENT MAP 15 

11. INDEX 16 

 



MANAGING LONG DOCUMENTS NOTES 
 

UNIVERSITY OF WOLLONGONG PAGE 3 NOTES 

Master Document 
 

Why use a Master Document 
 
 

 
• Large files can become corrupt 
• Large files are often slow to load and move through 
• Large files are sometimes difficult to edit 

 
• Master document allows you to create an automatic table of contents 

and index for combined files 
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1. Master documents and subdocuments 
A master document serves as a holder for separate files known as 
subdocuments. While every subdocument is actually a part of the master 
document, each is also a separate file. Once you’ve created a master 
document, you have the ability to view, reorganise, format, proof, print, and 
create a table of contents for multiple documents as if all the documents 
were one. 
 

1.1 The relationship between the master and its subdocuments 
In simplest terms, a master document is a Word document that contains one 
or more individual subdocuments. Figure A illustrates the dependant 
relationship between the master document and the subdocuments it contains. 
 

 
FIGURE A: A MASTER DOCUMENT SERVES AS A CONTAINER FOR ONE OR MORE 

SUBDOCUMENTS, WHICH WORD STORES AS INDIVIDUAL FILES THAT ARE LINKED TO THE 
MASTER. 

 
To view and manipulate the components of the master document, you must 
first switch to Master Document view. When you do, Word displays each of 
the subdocuments in the order in which they appear within the master. 
While working in a master document, you can rearrange the order of the 
subdocuments; you can also make changes globally (across each 
subdocument). 
 
Because each subdocument is stored as a separate file within the master 
document, multiple users can edit various subdocuments and Word 
automatically incorporates all of the changes made to a subdocument into 
the master document. Therefore, the master document always reflects the 
most recent version of each subdocument. 
 

1.2 Create a new master document 
1. Click New button, or File Menu — New. 
2. Switch to master document view. View menu — Outline. 
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1.3 To add an existing Word document into a master document 
1. Display the master document (in master document view). 
2. Expand the subdocuments. 
3. Click where you want to add the existing document. 
4. On the Master Document toolbar, click the Insert Subdocument 

button. 
5. Select the document you want to add, and then click Open. 
 

1.4 To print a master document 
1. Display the master document in master document view. 
2. Expand the subdocuments. 
3. Expand headings to display as much of the document as you want to 

print. 
4. File menu — Print. 
5. Print. 
 

1.5 Working with subdocuments 

1.5.1 Opening and editing subdocuments 
There are two ways to open a subdocument to begin your work. If you have 
the master document open and you’re in Master Document view, you can 
open a subdocument from within the master by double-clicking on the 
subdocument’s icon. You can then make changes to the subdocument. 
When you’ve finished, save your changes and then choose File — Close to 
close the subdocument. Word now reflects all of the changes (made to the 
subdocument) in the master document. 
 
You can also open a subdocument independently of the master. Choose File 
— Open or click the Open button on the Standard toolbar to display the 
Open dialog box. Navigate to the location of the subdocument, select it, and 
then click the Open button. Notice that the method for opening a 
subdocument from the Open dialog box is the same as it is for a regular 
Word document. 
 

1.5.2 Reorganizing subdocuments  
When changing the order in which the subdocuments appear within the 
master document, you can use either Outline view or Master Document 
view to do so. The technique and results are the same for both. The only 
difference is that in Master Document view, Word displays the 
subdocument icons to the left of each subdocument’s heading.  
 
To move an entire subdocument; 
1. Delete the subdocument. 
2. Re-insert the document into its new location. 
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1.5.3 Reorganising subdocument content 
You may have a situation where you don’t want to move an entire 
subdocument; instead you need to move only a portion of its contents. If 
that’s the case, you can easily move a specific part of a subdocument within 
a subdocument, or you can move it to another subdocument altogether. 
 
To move a portion of a subdocument’s content within the subdocument it 
currently belongs to, you’ll first need to expand the master document so you 
can see its contents. Then, select the content of the subdocument you wish 
to move and drag-and-drop the selection to a new location. 
 
If you need to move part of a subdocument to another subdocument, you’ll 
also need to expand all the levels of the master document. Once you display 
all of the subdocuments and their components, select the content you want 
to move, locate the subdocument you wish to move it to, and then drag-and-
drop. 
 
CAUTION: It’s very easy to move the contents of a subdocument from 
within the master document; however, you must be very careful not to 
delete the section breaks that separate each of the subdocuments. If you 
delete a Section Break between two subdocuments, Word combines the 
subdocuments, leaving just one subdocument in their places. Also, if you 
open a subdocument, you’ll notice that each section break is followed by a 
paragraph mark on a new page. Do not delete that mark; it serves as a 
subdocument divider. 
 

1.5.4 Changing subdocument divisions 
It’s easy to think of a master document as a book and the subdocuments as 
chapters of that book. As with writing a book, you may find that creating the 
perfect chapter (subdocument) isn’t always an easy task. Perhaps you have 
too much information for one subdocument to hold effectively; or possibly 
you have too many short subdocuments that are lacking cohesiveness. 
Although it can be difficult to create a set of subdocuments that suit your 
needs the first time you try, you’ll find that a master document provides the 
tools that make it easy to adjust your subdocuments until you achieve the 
desired outcome. 
 

1.5.5 Splitting and merging  
So, you’ve put too much information in a single subdocument and now you 
want to change it. The process is simple:  
 
1. Place your insertion point in the location where you want to split the 

subdocument (make sure the subdocuments are expanded). 
 

If you need to create a new heading at the location where you want to 
create the new subdocument, you can do so by entering the text and 
then applying the same heading style you used for the other 
subdocument headings. 

 

PLEA
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2. When you’re ready to split the subdocument into two subdocuments, 
oposition the cursor where you want the new subdocument to begin. 

 
3. Click the Split Subdocument button on the Master Document toolbar. 

When you do, Word automatically inserts a section break, splitting the 
subdocument into two subdocuments. 

 
4. Once Word completes the split, choose File — Save to save the master 

document. When you do, Word automatically saves the new 
subdocument to the master and assigns a name to the file using the 
heading text you selected during the split process. 

 
If you find that you actually have a subdocument that doesn’t include 
enough information to remain as one, you can merge it with another 
subdocument. To merge subdocuments: 
 
1. Select each of the subdocuments you wish to merge into one, making 

sure to select the entire contents of each (section breaks included). You 
can merge any of the subdocuments within the master as long as the 
subdocuments are next to one another. If the subdocuments you wish to 
merge aren’t in consecutive order, simply move them before 
completing the merge. 

 
2. Once you’ve selected the subdocuments, click the Merge 

Subdocument button on the Master Document toolbar. When you do, 
Word merges the selected subdocuments into one.  

 
3. Once Word completes the merge, choose File — Save to save the 

master document. When you do, Word automatically saves the new 
subdocument to the master and assigns a name to the merged file using 
the name of the first subdocument. You now have one subdocument; 
however, the second original document still exists as an individual file 
outside of the master document. To remove this file, navigate to the 
appropriate drive location, select the subdocument, and then press the 
Delete key. 

 

1.5.6 Renaming and moving subdocuments  
You can move an entire subdocument file to a different location, while still 
maintaining its link to the master document. You can also rename a 
subdocument. To change a file location without breaking the link to the 
master, you must open the subdocument from within the master document 
by double-clicking on its icon. While the master document is still open, 
choose File Save As from the main menu and navigate to the Save In 
location where you want to store the file. If you want to change the name of 
the file, enter a new name in the File Name text box. Once you’ve made 
your selections, click the Save button, exit the dialog box, and save the 
master document. 
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1.5.7 Removing subdocuments from the master 
If you want to completely remove a subdocument from the master 
document, simply select the subdocument and press the Delete key.  
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2.  Styles 
Thesis writers please note:  You MUST use styles when creating a master 
document.  This means that you MUST use styles for headings in your 
subdocuments (chapters).  
A Style is a set of paragraph and character format options that you name and 
store.  Word comes with a number of pre-determined styles.  Using styles 
can make document formatting faster and more consistent.  You can apply a 
style to any amount of text - from a single word to the whole document.  
You can save styles with a document and you can also use them in other 
documents. 
 
The following are the types of styles you can create and apply: 
A paragraph style controls all aspects of a paragraph's appearance, such as 
text alignment, tab stops, line spacing, and borders, and it can include 
character formatting. 
A character style affects selected text within a paragraph, such as the font 
and size of text, and bold and italic formats. 
A table style provides a consistent look to borders, shading, alignment and 
fonts in tables. 
A list style applies similar alignment, numbering or bullet characters, and 
fonts to lists. 
 
To see what styles are available in your document go to the Style box and 
click on the pointer.   

2.1 Applying a Style 
To apply a style to a paragraph, or text, place the insertion point anywhere 
in the paragraph or select any amount of text, then select the paragraph style 
from the Style box.  The command will affect the whole paragraph.  NB:  
you can also select several paragraphs at once and alter the style. 
 
When you apply a style to a paragraph, you can then select the other 
paragraphs you want to change and choose Repeat Style  from the Edit menu 
to apply the style.   
 

2.2 Working with Styles  
The easiest area for working with styles is the Styles and Formatting task 
pane.  To open the palette, click the  button on the formatting toolbar or 
go to the Format menu and select Styles and Formatting.  
 

2.3 Modifying  Styles 
Click within a piece of text that has the style you wish to modify (or choose 
the name of the style from those listed on the palette).  The style name will 
appear in the first field in the palette.  
Click on the pointer to the right of the style name and choose Modify Style.  
Select any options you want. To see more options, click Format, and then 
click the attribute— such as Font or Numbering— that you wish to change.  
Click OK after you've changed each attribute, and then repeat for any 
additional attributes you want to change. 
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To use the modified style in new documents based on the same template, 
select the Add to template check box. Word adds the modified style to the 
template that is attached to the active document. 
 
To update all text formatted with that style throughout the document click 
the automatic update button. 

2.4 Redefining the Default (Normal) Style 
You can modify the formats of the Normal style so that all new documents 
will take on that format. 

1. Open a new document 
2. Open the Styles and Formatting palette 
3. Click on Normal 
4. Make changes 
5. Click the Add to Template checkbox. 

 

2.5 Creating New Styles 
Using Existing Text: 

1. Select a paragraph and format it 
2. Click in the Style Text Box 
3. Delete the Style name and type a new name 
4. Press Enter 

 

2.6 Using the Style Command: 
1. Open the Styles and Formatting Palette 
2. Click on the New Style button 
3. In the window which opens, type a name for the new style in the 

Name text box and select the type of style you want to create from 
the Style type  drop-down list 

4. To base the style on another, choose from the Based on  drop down 
list.   

5. Click on any formatting you require – remember there are more 
formatting choices under the Format button 

6. Click OK to define the style 
 

2.7 Deleting a Style 
1. Open the Styles and Formatting Palette 
2. Select the style you want to delete  
3. Click on the pointer to the right of the style name 
4. Click Delete  

 

2.8 Copying a Style to the Normal Template 
You can copy styles from one document or template to another.  If the 
copied style has the same name as an existing style in the document to 
which you copy it, Word will ask you to confirm that you want to replace 
the existing style.  
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• Go to the Tools menu and choose Templates and Add-Ins 
• Click the Organizer button 

 
Word displays the styles used in the active document or its attached 
template in the list on the left.  Styles used in the Normal document template 
are listed on the right.  
To copy styles to the Normal template,  

• Highlight the Style on the left you wish to copy across 
• Click the Copy button (Make sure the arrows are pointing the right 

way) 
• Click Close 

 

2.9 Copying a Style to Other Templates or Documents 
If you wish to copy the style to a template other than the Normal template 
Go to the Tools menu and choose Templates and Add-Ins 
Click the Organizer button 
Word displays the styles used in the active document or its attached 
template in the list on the left and the styles used in the Normal template on 
the right. 
Click the Close File button under the Normal template (right side).  Now 
click Open File and choose the template or document from the dialogue box, 
that you wish to copy the style to 
Highlight the Style on the left you wish to copy across 
Click the Copy button (Make sure the arrows are pointing the right way) 
Click Close 
 
 

3. What Styles Don’t Control 
Styles don’t control any settings in the Document, Page Setup or Section 
dialogue boxes.  Therefore any changes you make to a style won’t affect a 
document’s margins, page orientation, the number of columns on a page, or 
any printer effects you want to use.  In other words, the general layout of 
your document pages must be set manually.  Once you take care of the 
layout, however, styles make it easy to format the individual paragraphs in a 
document. 
 
 

4. Page Numbers 

4.1 Adding basic page numbers to headers or footers to your 
Master Document. 

 
1. Go to your Master Document. 
 
2. View Menu, select Print Layout. 
 
3. Go the first page ‘Title’. 
 

Hint: 
You can print a list 
of the styles in your 
document by 
selecting Styles 
from the Print What 
drop-down list box 
in the Print dialogue 
box. 
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4. Insert Menu, Page Numbers. 
 
5. Format as i ii iii. 
 
6. Show number of first page, deselect. 
 
7. Click OK. 
 
Scroll down through the pages until you get to main content pages. Note the 
footer page number is no longer in roman numerals. 
 
1. Click within the Footer/Header, select Format Page Numbering from 

the Header and Footer Toolbar. If the toolbar is not available go to 
the View Menu,  Header and Footer. 

 
 

5. Footnotes 

5.1 Insert a footnote 
1. Click where you want to insert the note reference mark1. 
 
2. Insert menu — choose Footnote. 
 
3. Type the note in the footnote panel, and then click in the document to 

continue typing. 
 

6. Endnotes 
Please see the library regarding using Endnote. 
 
 

7. Index 

7.1 Create an index 
To create an index, you must first mark the index entries — words, phrases, 
etc. in your document. 
1. Select the text you want to use as an index entry. 
 
2. Press Command Option Shift x. [Alt Shift x] 
 
3. To create a main index entry, type or edit the text in the Main Index 

Entry dialog box. 
 
 To create a subentry, type the text in the Subentry box. To include a 

third level entry, type the subentry text followed by a colon and the text 
of the third-level entry. 

 
                                                 
1 A number, character, or combination of characters that indicates that additional information is 

contained in a footnote or endnote. 

Footnotes 
and 
endnotes 

Index 
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4. To mark the index entry, click Mark. 
 
 To mark all occurrences of this text in the document, click Mark All. 
 
5. To mark additional index entries, select the text or click immediately 

after it, click in the Mark Index Entry dialog box, and then repeat 
steps 3 and 4. 

 

7.2 Automatically mark index entries by using a concordance 
file2 

Refer to Microsoft Word Help. 
 

7.3 Building an index 
1. Mark in the index entries as above (5.1). 
 
2. Open the Master Document. 
 
3. Expand the Sub documents. 
 
4. Click where you want to insert the finished index. 
 
5. Insert menu — Index and Tables, and then click the Index tab. 
 
6. Use one of the available designs or create your own. 
 

7.4 Updating an index 
1. Click in anywhere in the index, and press F9 (function key on your 

keyboard). 
 
 

                                                 
2 An index file with a two column table: The first column lists the text in the document that you want 

to index, the second column lists the index entries to generate from the text in the first column. 
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8. Table of contents (TOC) 

8.1 Creating a table of contents in a master document 
1. Display the master document. 
 
2. Expand the subdocuments, 
 
3. Click where you want to insert the table of contents. 
 
4. Insert menu —  Reference, Index and Tables, Table of Contents tab. 
 
5. To use one of the available designs, click a design under Formats, or 

specify a custom table of contents layout. 
 

8.2 Updating a table of contents 
1. Click in anywhere in the table of contents, and press F9 (function key 

on your keyboard). 
 
 Note: When you update the entire toc, any text or formatting that you 

have added will be lost. 
 

9. Table of figures, images, graphs, tables. 

9.1 To create a Table of figures, you have to add captions to 
your figures (images, graphics, graphs etc.) 

 
Adding captions manually to an existing figure, images, graph, table or 
other item 
 
1. Select the item (figure, graph, etc). Insert menu, Reference, Caption. 
 
2. In the label list, select the item for which you want Word to insert a 

caption. 
 

9.2 Inserting a Table of Figures, List of Tables, etc. 
 
Go to the document where you want to insert the table of figures. 
 
1. Insert menu, Reference, Index and Tables. 
 
2. Click the Table of Figures tab. 
 

Table of 
contents 

NOTE: TURN OF 
HYPERLINKS. 
 
OPEN SUBDOCUMENT 
TO REDEFINE THE TOC 
STYLES 

Table of 
figures 
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3. In the Caption label box, click the type of caption label you want to 

compile in the table of figures. 
 
4. Note, in your Master document you will need to update field, to enable 

word to re-number the Figure 1, Figure 2 etc. 

10. Document Map 
 
The Document Map is a separate pane that displays a list of headings in the 
document. Use the Document map to quickly navigate through the 
document and keep track of your location in it. 
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